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Equipment List 
Motion detector 
Force probe  
Level 
211 friction cart with reflector 
Standard cart track setup 
Meter stick 
Set of 3 wood blocks including one with a reflector 
 
 
Computer File List 
MacMotion file Ò211-03 Block DragÓ 
MacMotion file Ò211-03 Data Entry 1Ó 
MacMotion file Ò211-03 Up and Down the InclineÓ 
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Investigation 1:  Static and Kinetic Frictional Forces  
  
Goal: • To study the characteristics and origins of frictional forces 
 
Introduction: If you want to drag a crate between two points along the ground, you need to (a) 

find a better hobby, and (b) apply a non-zero force to get the crate moving and 
keep it moving.  The latter requirement results from the fact that there is a force 
exerted by the ground on the crate which acts parallel to the surface of the 
ground and in the direction opposite that of your applied force. 

 This parallel force is called a frictional force, and it exists between two surfaces 
in contact with each other either 

  • when one surface is sliding along the other surface (kinetic friction), or 
  • when the surfaces are being pushed relative to one another, but are not  

 moving (static friction). 
 In the following activity, you will study both static and kinetic frictional forces. 

  

Activity 1:  The Great Works of Friction 

Introduction: In this activity, you will use the force probe to examine the frictional forces 
present between a block and the aluminum track when the block is at rest and 
when it is sliding. 

Procedure: 1. Measure and record the mass of your block. 

 m =  ________ kilograms 
  
 2.  Open the MacMotion program, by double-clicking on the MacMotion icon. 
 •  Open... (under the File menu) the file BLOCK DRAG in the Lab 3 folder.  

The graph in Figure 1 should appear on the screen. 

    
  Figure 1.  Block drag graph format for Activity 1 
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Procedure: 3. Set up the block, track, and force probe as shown in Figure 2.  The motion 
(continued)       detector should already be mounted on the track.  Don't let the block get too 

close to the detector. 

 

 

 

   force probe 
(pull horizontally)

track

block

0.5 
 m

 motion 
detector

 

Figure 2.  Experimental setup for Activity 1 
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Prediction: •Sketch in Figure 3 the velocity vs. time and (pulling) force vs. time graphs you 
 expect if you slowly pull an initially stationary block with the force probe until 
 the block is sliding with a constant velocity.  Make sure to label important 
 features as carefully as possible, including: 

 • the behavior of the applied force and block velocity before the block begins 
to slide  

 • the behavior of the applied force and block velocity after the block begins 
to slide 

 • the kinetic and static frictional forces 

    
 Figure 3.  Predicted force and block velocity for Activity 1 
  
Procedure: 4. Zero the force probe while it is in the horizontal position shown in Figure 2 
(continued)  (with no force applied), by clicking Zero on the bottom of the screen. 
 
 5. Make a graph while pulling a single block. 
  • Place the block with a force probe attached beyond the 0.5 meter line. 
  • Start graphing, then pull very gently on the block with the force probe 

(away from the motion detector), increasing the force very slowly. 
  • When the block begins to move, pull only hard enough to keep it moving 

with a small velocity which is as constant as possible. 
 6. Estimate as accurately as possible from your graphs the values of the 

maximum static and mean kinetic frictional forces, Fs and Fk, and record in 
Table 1, as well as in the first row of Table 2 for later comparison. 

Mass of Block  (kg) Maximum Static 
Frictional Force, Fs  (N)

Mean Kinetic 
Frictional Force, Fk  (N)

   

 

Table 1.  Static and kinetic friction results from Activity 1
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Procedure: 7. Move your graphs to Data B so they will be available to compare with 
(continued)    graphs created later. 
 

Questions: •Locate the time on your force graph when the block began to move.  What 
features identify this time? 

  __________________________________________________________ 
  __________________________________________________________ 

 •As you pull harder and harder, but before the block starts moving, what 
happens to the frictional force exerted on the block by the track? 

  __________________________________________________________ 

 •What happens to the frictional force just as the block begins to slide?  Look at 
your graph carefully.  What is the explanation for this behavior? 

  __________________________________________________________ 
  __________________________________________________________ 



© University of Illinois  Physics 211 - Lab 3  Page 5 of 17  
 

Activity 2:  It’s Rough In Here:  The Coefficients of Friction 
 
Introduction: A measure of the static and kinetic friction present between two surfaces in 

contact is provided by the coefficients of friction.  In this activity you will examine 
how static and kinetic frictional forces vary as the normal force between an 
object and a surface is changed, and with your results you will estimate the 
coefficients of static and kinetic friction for the surfaces involved. 

 
Procedure: Be sure that your graphs from Activity 1 are still in Data B (green). 
 1. If you haven’t already done so, record your results from the previous activity 

 in the appropriate (1 block) row of Table 2. 

Prediction: •How do you expect both the static and kinetic forces on the block to change 
 with increasing block mass?  If possible, write your answer mathematically, 
 including as much information as you can. 

 ___________________________________________________________ 
 ___________________________________________________________ 
 

 2. Repeat the experiment in Activity 1, this time with increasingly larger mass. 
  • Place a second block securely on top of the first block in order to 

roughly double its mass. 
  • Determine the mass of, and normal force on, the two blocks; record 

these values in Table 2. 
  • Zero the force probe (with no force applied), by placing the probe 

horizontally on the track as in Activity 1. 
  • Pull the block exactly as in the last activity:  start with the string loose, 

then gradually pull very gently. After the block starts moving, move it as 
closely as possible to the same constant velocity as before. 

 3. Measure the forces.   
  • Select Analyze Data A from the Analyze menu. 
  • Estimate from your graph (Data A) the maximum static frictional force 

just before the block starts sliding.  Record this result in Table 2. 
  • Estimate from your graph the average kinetic frictional force while the 

block is sliding with a constant velocity using the averaging capability of 
the computer. Record your result in Table 2 below. 

 4. Make a labeled record of your comparative experiment. 
   • Set Graph Title... to include your names and the phrase "ONE AND TWO 

BLOCKS".  
  • Print one copy for your group.  Label your graphs (e.g., "One  Block," 

"Two Blocks"). 
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Procedure: 5. Make a third and final measurement, this time with three blocks. 
(continued)  Securely add a third block and zero the probe (horizontally). 
  • Determine the mass of, and normal force on, the three blocks and 

record these values in Table 2. 
  • Gently pull the blocks until they move with the same constant velocity as 

in step 2. 
  • Determine the maximum static and mean kinetic  frictional forces, and 

record these values in Table 2 below. 
  

No. of 
Blocks 

Mass of  
Block(s) (kg) 

m  

Normal Force 
(N) 

F⊥ = Fg = mg  

Maximum Static 
Frictional Force,

Fs   (N) 

Mean Kinetic 
Frictional Force,

 Fk   (N) 

0 0 0 0 0 

1     

2     

3     

    Table 2.  Frictional force results for Activity 2 
 

Questions: •How does the maximum static frictional force vary as the normal force is  
  increased?  Try to state a precise mathematical relationship. 
 ___________________________________________________________ 
 ___________________________________________________________ 

 •How does the kinetic frictional force appear to vary as the normal force is 
 increased?  Again, try to state a precise mathematical relationship.   

 ___________________________________________________________ 
 ___________________________________________________________ 
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 An Aside:  Coefficients of Friction 
 Static friction between two surfaces is characterized by the coefficient of static 

friction, µs, which relates the maximum frictional force to the normal force.  You 
should have found experimentally in the previous experiment that both the static 
and kinetic frictional forces, Fs and Fk, are proportional to the normal force, Fn. 

 The coefficient of static friction, µs, relates the static frictional and normal forces, 
  Fs = µsFn, (Eq. 1) 

 and thus the maximum static frictional force is related to the normal force by the 
relationship, 

   Fs,max = µsFn (Eq. 2)
  

 Similarly, the coefficient of kinetic friction, µk, relates the kinetic frictional force to 
the normal force, according to the relationship, 

  Fk = µkFn  (Eq. 3) 
 
 
 
Procedure: 6. Estimate the coefficients of friction in your experiment. 
(continued)   
  By plotting your measured values (see Table 2) for maximum static friction, 

Fs,max, and mean kinetic friction, Fk, as a function of the measured normal 
force, Fn,  you should be able to estimate the coefficients of static and kinetic 
friction, µs and µk, in your experiment. 

  •  Open... the file DATA ENTRY 1 in the Lab 3 folder. 
  • Select Data A Table under the Windows menu.  You should see a new 

window labeled "Data A" similar to that shown in Figure 4. You can 
enter numerical data directly into the table in the spaces shown. 

  • Record your maximum static frictional force, mean kinetic frictional 
force, and normal force values in the three columns in the on-screen 
table illustrated in Figure 4. 

  • When all your data has been entered, click once on the graph window to 
bring it to the front and view your points. 

  • If static friction, Fs,max (F_s,max), is not already displayed on the y-axis, 
select this data set by clicking the mouse cursor on the y-axis label and 
dragging down to select F_s,max. 

  • Double-click on the graph window and adjust the scale so that your 
points are visible. 
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 Figure 4.  Data entry table for maximum static friction, Fs,max (F_s,max), kinetic friction, Fk (F_k) 

and normal force, Fn (F_n)  
 

Procedure: 7.  Create a "fit" to your static friction (Fs,max) data. 
(continued)   
  • Select Fit... under the Analyze menu.  A dialog like that in Figure 5 will 

appear in which you can specify the kind of mathematical formula to try. 
  • Make sure that Linear is selected, as above, and then click on Maintain 

Fit.  You should see a straight line on top of your graph.  The computer 
has tried to draw a "best fit" through all the data points. 

  • Re-adjust your display scale if necessary to better view the points. 
  • Record the slope of the “best fit” through your static friction vs. normal 

force data below. 
    
    b1

stat = _______ 
 

 
 Figure 5.  Window for selecting a fitting function for your plot in Activity 2   
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Procedure:  8.  Create a "fit" to your kinetic friction, Fk (F_k), data. 
(continued) 
  • Select the kinetic friction (Fk) data set by clicking the mouse cursor on 

the y-axis label and dragging down to select F_k. 
 • Rescale if necessary so that there is not a lot of blank space. 
 • Fit your data with a linear function by repeating step 7 for the kinetic 

friction (Fk) data set. 
 • Record the slope of the “best fit” through your kinetic friction vs. normal 

force data below. 
      b1

kin = ________ 
 
 9. What is the relationship between the “best fit” slopes through your data, b1, 

 and the coefficients of static and kinetic friction, µs and µk? 
 
 ___________________________________________________________ 
 
   Use this relationship and the slopes through your data to obtain measured 

values for µs and µk.  Record these values in Table 3. 
 

Quantity Measured 

µk  

 µs  

 Table 3.  Results for coefficients of friction in Activity 2 

Questions: •Are your results for the coefficients of static and kinetic friction, µs and µk in 
Activity 1 reasonable?  Why or why not? 

 ___________________________________________________________ 
  ____________________________________________________ 

 •Several objects lie in the bed of a truck that is initially at rest.  The coefficient of 
static friction between the truck bed and the objects is µ.  If the truck slowly 
increases its acceleration from zero, will the objects slide initially?  Why or why 
not?  If the truck continues to increase its acceleration, what will eventually 
happen to the objects?  Can you write an equation describing the condition 
under which this will happen? 

 ___________________________________________________________ 
  ____________________________________________________ 
  ____________________________________________________ 
  ____________________________________________________ 
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Investigation 2:  Motion in the Presence of a Frictional Force 
 

Activity 3:  Look What the Cart Dragged On 
Introduction: You have already studied in Laboratory 1 the kinematics of a cart traveling up 

and down an inclined ramp, and you should have found that this motion is in 
many respects analogous to throwing a ball straight up in the air.  In order to 
examine how friction and other damping forces influence the kinematics of 
objects, you will study in this activity the influence of a constant drag force on a 
cart moving up and down an inclined ramp (Figure 6 (b)).  With regard to our 
“tossed ball” analogy, this is tantamount to including the viscous drag effects of 
the air on the ball (Figure 6 (a)).  (Actually, the latter case is somewhat more 
complicated, as the drag force is not constant in the case of air resistance, but is 
instead a function of the object’s velocity.  Nevertheless, the qualitative behavior 
explored in this activity is similar to that of a ball tossed into the air). 

 

g

|g | = 9.81 m/s2

(a).

θ

θ

geff

geff

g

(b).

Fkin

 air F
drag

v

 

Figure 6.  Comparison between (a) “free-fall” motion and (b) a cart rolling down an incline in 
 the presence of a drag force 
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Procedure: 1. Set up the motion detector, ramp and cart as shown in Figure 7.   
  • Raise the detector end of the ramp about 15 cm above the level track 

height (x = 15 cm), and make sure that the motion detector has a good 
view of the cart all the way down the ramp.  Initially, there should be no 
friction set on the cart. 

            
Figure 7.  Experimental setup for Activity 3 

 
  • Measure and record x and L (see Figure 7), as well as the mass of the 

cart in your experimental setup, for later analysis. 
 x =  _____________ L =  ____________ mcart = ___________ 
 
 2. Set up to graph distance, velocity, and acceleration.   
 • Open UP AND DOWN THE INCLINE in the Lab 3 folder.  The graph shown 

in Figure 8 should appear. 
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Figure 8.  Up and down the incline graph format for Activity 3 
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Procedure: 3. Perform the experiment without friction. 
(continued)    
  • Click on Start.  Wait until you hear the clicking of the motion detector, then 

 push the cart so that it travels up the incline and back.  Repeat if 
 necessary to obtain a “nice” set of curves. 

 
 4. Record your measured value for the cart’s acceleration.  You should use 

 the averaging capability of the computer, and obtain the mean acceleration 
 exhibited by the cart in the absence of friction (be sure to average only a 
 range of values over which the cart experiences a roughly constant 
 acceleration). 

 acart  = ____________ 
 
 5. Move your plots to Data B so they will be available to compare with graphs 

 created later. To do this, use Data A-->Data B in the Data menu. 
 
 6. Add friction to your experiment.  Leaving the track and graph configurations 

 untouched, adjust the friction pad, enough so that there is substantial 
 contact between the pad and the track, but not so much that the cart no 
 longer accelerates down the incline.  You are now ready to repeat the 
 previous measurement with friction present. 

Predictions: Below you will make several predictions about the effects of friction on a cart 
which rolls up and down and incline.  To help you with these predictions, 
consider Figure 9, which shows the free-body (force) diagrams for the cart in the 
case of (a) motion up the incline and (b) motion down the incline, in the 
presence of a constant frictional force.  If you don’t understand the free-body 
diagrams, ask your TA for help. 

θ

v

θ

v

(a).  Motion up the incline (b). Motion down the incline

N N

Fkin
mgsinθ

mgsinθ
Fkin

mgcosθ mgcosθ

x

y
+

x

y
+

 
Figure 9.  Free body diagrams for motion of a cart (a) up an incline and (b) down an incline in 
 the presence of friction 

 •For both cases (a) and (b) in Figure 9, write below Newton’s second law for the 
 net force acting on the cart in the x-direction.  Take the positive x- and y-
 directions to be those defined by the axes shown in Figure 9. 

(a). F
x
net  =  ______________________ =  maup (b). F

x
net  = ___________________ = madown 
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Predictions: •Now, on the graph in Figure 10 below, sketch using a dashed line your 
(continued)  results from the first part of this activity for the motion of the cart without  
  friction.  Next, after studying your free body diagrams above, sketch with  
  solid lines your predictions for the acceleration vs. time and velocity vs.  
  time plots of a cart moving up and down an incline in the presence of  
  friction.  Clearly label significant features that you expect in the plot. 
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 Figure 10.  Predictions for velocity and acceleration for Activity 3 

Procedure: 7. Test your predictions:  repeat the previous experiment with friction present.   
(continued)   
  • Click on Start.  Wait until you hear the clicking of the motion detector, 

 then again push the cart so that it travels up the incline and back. 
 Repeat if necessary to obtain a “nice” set of curves. 

 8.  Print your results, using Set Graph Title... to label it with your names and 
 the title UP AND DOWN WITH FRICTION.  Make a copy for each person. 

 9.  Take your printout and label your velocity graph only with— 
  "A" where the cart started being pushed 
  "B" where the push ended (where your hand left the cart) 
  "C" where the cart reached the top (and is about to start down) 
  "D" where the cart reached the bottom again 
 

Question: •How did you identify each of the points in step 9? 

 ___________________________________________________________ 
 ___________________________________________________________ 
 ___________________________________________________________ 
 ___________________________________________________________ 
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Procedure: 10. Analyze your data.  You are now in a position to determine the values of 
(continued)   the force of kinetic friction, Fkin, and of the coefficient of kinetic friction, µk,

 present in your experiment.   
 • Record your measured value(s) for the cart’s acceleration in the 

presence of friction for motion both up and down the incline. Use the 
averaging capability of the computer, and obtain the mean acceleration 
in each range (be sure to average only a range of values over which the 
cart experiences a roughly constant acceleration). 

 aup   = ____________  adown  = ____________ 
 

 11.  Find a relationship between Fkin, aup, and adown that does not depend on the 
 angle θ.   To do this, combine the force equations ((a) and (b)) you 
 derived in your predictions so that the angle θ is eliminated.  Write this 
 relationship below. 

 
Fkin = _____________________ 

 
  
 12.  Using the measured values above, calculate the value of the kinetic  

 frictional force in this experiment, and write this estimate below (with units). 
 

Fkin = ______________ 
 

  
 13. Below, write the relationship between the kinetic frictional force, the normal 

 force, and µk. 
 

µk = ______________ 
 

  
 14.  Using known and measured values, obtain a value for the coefficient of 

 kinetic friction in your experiment.  Record this value below. 

  

µk = ______________

 
 

Question: •Is your value for the coefficient of kinetic friction in this activity reasonable?  
 Why or why not? 

 ___________________________________________________________ 
 ___________________________________________________________ 
 ___________________________________________________________ 



© University of Illinois  Physics 211 - Lab 3  Page 15 of 17  
 

Activity 4:  “I’ve Fallen, and I Can’t Speed Up!” 
Introduction: Drag forces are funny things.  If you fall out of a car at high speeds, drag forces 

are bad.  But if you fall out of an airplane at high altitudes, the drag force 
becomes your best friend (and possibly your last).  Why?  An object falling in 
response to the gravitational force, but also subject to a viscous drag force, will 
eventually reach a “terminal” speed at which the acceleration of the object is 
zero.  Parachutes, for example, are designed to dramatically reduce a skydiver’s 
terminal speed (note again that this situation is more complicated than that 
explored in this Activity, as the drag force is not constant in the case of air 
resistance).  In the following activity, you will use the cart and incline to study the 
conditions under which an object in the presence of friction can “fall” with a 
constant velocity. 

Procedure: In this activity, you will keep the cart friction the same as in the last activity, and 
you will vary the inclination angle θ until the cart attains a constant velocity. 

 1. Leave your experimental setup the same as in the previous activity (see 
 Figure 9).  Important:  Do not alter the friction pad adjustment from that used 
 in the last activity!   

 2. Keep the distance, velocity, and acceleration plots the same as in the 
 previous activity. 

Predictions: Consider the free body diagram for a cart rolling down an incline in Figure 11. 

 

N

Fkin

mgsinθ

mgcosθ

θ

v (= constant) x

y
+

 
Figure 11.  Free body diagram for Activity 4 

 •Assume that a cart is sliding down an incline in the presence of friction.  Use 
the diagram in Figure 11 to determine a relationship for kinetic friction, Fkin (in 
terms of given parameters, m, g, and θ), when the cart slides down the incline 
with a constant velocity, acart = 0.  Take the positive x- and y-directions to be in 
the directions shown by the axes in Figure 11. 

Fkin = ____________________________ 

 •Now, use the definition of kinetic friction, Fkin = µkN, and the diagram in 
 Figure 11 to derive an expression for the “critical” angle at which the cart will 
 travel down the incline with a constant velocity.  

θcrit = _________________ 
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Predictions: •Using your measured values from the previous activity, predict the 
(continued)  inclination angle, θcrit, at which the cart will slide down the incline with a 

 constant velocity, and record this value in Table 4. 
  

 •Sketch with dashed lines in Figure 12 the velocity and acceleration   
  you expect for a cart rolling down an incline with angle θ = θcrit. 
 

 
    Figure 12.  Predictions for Activity 4 

 
Procedure: 3. Test your predictions. 
(continued)   
 • Without adjusting the friction pad on the cart, decrease slightly the 

inclination angle, θ, of the track. 
 •  After adjusting the angle, click Start, then give the cart a small push, 

and let it slide down the incline.  Check your results.  Keep varying the 
inclination angle and repeating the measurement until the cart travels 
down the incline with a velocity that is as constant as possible.  Sketch 
your results with a solid line in Figure 12. 

 
 4. Measure the “critical” angle, θcrit, of the incline, by carefully measuring x 

 (see Figure 7) and using your previous value of L.  Record your predicted 
 and measured values for θcrit in Table 4. 

 

Quantity Predicted    Measured 

θcrit   

  

Table 4.  Predictions for the critical inclination angle in Activity 4 
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Questions: •How closely did your measurement of the “critical angle” match your 
 prediction?  What are the possible sources of error? 

 ___________________________________________________________ 
 ___________________________________________________________ 

 •If you adjust the inclination angle so that it is significantly larger than the 
 “critical” angle, θcrit, i.e., θ > θcrit, then give the cart a small push at the top of 
 the incline, how will the cart behave?  Give as detailed a description of this 
 behavior as possible, and explain your reasoning. 

 ___________________________________________________________ 
 ___________________________________________________________ 
 ___________________________________________________________ 
 ___________________________________________________________ 
 


